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Chapter 1: Welcome to Pro Tools
Welcome to Pro Tools® by Digidesign®. 
Pro Tools integrates powerful multitrack digital 
audio and MIDI sequencing features, giving you 
everything you need to record, arrange, com-
pose, edit, mix, and master professional quality 
audio and MIDI for music, video, film, and mul-
timedia.

The Pro Tools Guides
In addition to any printed guides or documenta-
tion included with your system, PDF versions of 
the printed guides and many additional 
Pro Tools guides and Read Mes are installed au-
tomatically during Pro Tools installation to the 
Digidesign/Documentation folder. To view or 
print PDF guides, you can use Adobe Reader or 
Apple Preview (Mac only).

Setup Guide

The printed Setup Guide for your system includes 
instructions for installing Pro Tools and con-
necting your studio. 

Printed copies of the Pro Tools Reference 
Guide and some guides in the Pro Tools 
guide set can be purchased separately from 
the DigiStore (www.digidesign.com).
Getting Started with Pro Tools Guide

For Pro Tools LE® and M-Powered™, see the 
Getting Started with Pro Tools Guide for your 
interface.

This guide has tutorials on using Pro Tools (such 
as recording in a Pro Tools session, importing 
audio from a CD, and creating an audio CD 
from a Pro Tools session).

Guides Accessible in Pro Tools

The main Pro Tools guides are accessible from 
the Pro Tools Help menu. These include:

• Shortcuts, which lists keyboard and Right-click 
shortcuts for Pro Tools including those shown 
in Pro Tools menus.

• DigiRack Plug-ins Guide, which describes the 
DigiRack plug-ins included with Pro Tools 
for both real-time and file-based audio 
processing.

• Pro Tools Menus Guide, which covers all the 
Pro Tools on-screen menus.

• Pro Tools Reference Guide, which explains 
Pro Tools software in detail. 
Chapter 1: Welcome to Pro Tools 3
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Additional Plug-in Guides

For information on additional free plug-ins that 
can be installed with Pro Tools, and for informa-
tion on additional plug-ins that you can pur-
chase separately, see the following PDF guides:

• Bomb Factory Plug-ins Guide, which describes 
the Bomb Factory plug-ins.

• Creative Collection Plug-ins Guide, which 
describes the Digidesign Creative Collection 
instrument and effects plug-ins that can be 
installed with Pro Tools. 

• Digidesign Plug-ins Guide, which describes the 
Digidesign® plug-ins.

• TL Labs Plug-ins Guide, which describes the 
TL Labs plug-ins.

These guides are installed with Pro Tools and 
can be found in the following locations:

Windows C:\Program Files\Digidesign\
Documentation\Plug-ins

Mac Applications/Digidesign/Documentation/
Plug-ins

Expanded Systems Guide

(Pro Tools|HD Systems Only)

This PDF guide provides instructions for 
expanding a Pro Tools|HD® system with addi-
tional Digidesign cards and audio interfaces, 
with or without an expansion chassis.

Additional Digidesign Printed Guides

Digidesign also provides guides with Pro Tools 
audio interfaces, dedicated worksurfaces (such 
as D-Control™) and control surfaces (such as 
Command|8®), and other Digidesign options 
(such as MIDI I/O™, PRE, and SYNC HD™). 
Refer to the separate guide provided with each 
Digidesign product.
Pro Tools Reference Guide
Conventions Used in These Guides

The Pro Tools guides use the following conven-
tions to indicate menu choices, keyboard com-
mands, and mouse commands:
:

The names of Commands, Options, and Settings 
that appear on-screen are in a different font.

The following symbols are used to highlight 
important information:

Pro Tools M-Powered

Convention Action

File > Save Choose Save from the 
File menu

Control+N Hold down the Control 
key and press the N key

Control-click Hold down the Control 
key and click the mouse 
button

Right-click Click with the right 
mouse button

User Tips are helpful hints for getting the 
most from your Pro Tools system.

Important Notices include information that 
could affect your Pro Tools session data or 
the performance of your Pro Tools system.

Shortcuts show you useful keyboard or 
mouse shortcuts.

Cross References point to related sections in 
this guide and other Digidesign guides.

References to Pro Tools LE™ in this guide 
are usually interchangeable with Pro Tools 
M-Powered™, except as noted in the 
Pro Tools M-Powered Setup Guide.



System Requirements and 
Compatibility Information
Digidesign can only assure compatibility and 
provide support for hardware and software it has 
tested and approved. 

For complete system requirements and a list of 
Digidesign-qualified computers, operating 
systems, hard drives, and third-party devices, 
refer to the latest information on the Digidesign 
website:

www.digidesign.com/compatibility
About www.digidesign.com
The Digidesign website (www.digidesign.com) is 
your best online source for information to help 
you get the most out of your Pro Tools system. 
The following are just a few of the services and 
features available. 

Product Registration Register your purchase 
online. 

Support and Downloads Contact Digidesign 
Technical Support or Customer Service; down-
load software updates and the latest online 
manuals; browse the Compatibility documents 
for system requirements; search the online An-
swerbase; or join the worldwide Pro Tools com-
munity on the Digidesign User Conference. 

Training and Education Study on your own using 
courses available online or find out how you can 
learn in a classroom setting at a certified 
Pro Tools training center. 

Products and Developers Learn about Digidesign 
products; download demo software or learn 
about our Development Partners and their plug-
ins, applications, and hardware. 

News and Events Get the latest news from 
Digidesign or sign up for a Pro Tools demo.

Pro Tools Accelerated Videos Watch the series of 
free tutorial videos. Accelerated Videos are de-
signed to help you get up and running with 
Pro Tools and its plug-ins.
Chapter 1: Welcome to Pro Tools 5
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Chapter 2: Pro Tools Concepts
This chapter explains some of the principles and 
concepts that form the foundation of Pro Tools 
operation and functionality.

Hard Disk Audio Recording
Hard disk recording is a nonlinear (or random ac-
cess) medium—you can go immediately to any 
spot in a recording without having to rewind or 
fast forward.

This differs from tape-based recording, which is 
a linear medium—where you need to rewind or 
fast forward to hear a particular spot in a record-
ing. To rearrange or repeat material in a linear 
system, you need to re-record it, or cut and 
splice it. 

Nonlinear systems have several advantages. You 
can easily rearrange or repeat parts of a record-
ing by making the hard disk read parts of the re-
cording in a different order and/or multiple 
times. In addition, this re-arrangement is nonde-
structive, meaning that the original recorded ma-
terial is not altered.
Pro Tools Nonlinear Editing
Pro Tools is a nonlinear recording editing sys-
tem that lets you rearrange and mix recorded 
material nondestructively. Nonlinear editing 
simply means that you can cut, copy, paste, 
move, delete, trim, and otherwise rearrange any 
audio, MIDI, or video in the Pro Tools Edit win-
dow. 

Nonlinear editing provides significant advan-
tages over dubbing (re-recording), and cutting 
and splicing magnetic tape. It gives you the 
greatest possible flexibility for editing and ar-
ranging, and it is all nondestructive and “undo-
able.” Additionally, with nonlinear editing in 
Pro Tools, you will never introduce any degrada-
tion of audio fidelity as you would with tape.
Chapter 2: Pro Tools Concepts 7





MIDI
MIDI (Musical Instrument Digital Interface) is a 
communication protocol for musical instru-
ments. This industry standard enables connec-
tions between a variety of devices from different 
manufacturers. Examples of MIDI-compatible 
equipment include synthesizers, sound mod-
ules, drum machines, MIDI patch bays, effects 
processors, MIDI interfaces, MIDI control sur-
faces, and MIDI sequencers. 

MIDI devices are equipped with 5-pin DIN con-
nectors, labeled as either IN, OUT, or THRU. The 
MIDI OUT port transmits messages. The MIDI 
IN port receives messages. The MIDI THRU out-
puts whatever is received from the IN port. MIDI 
devices are connected with MIDI cables that are 
available at most music stores. 

USB and FireWire-compatible MIDI devices send 
and receive MIDI messages to and from the 
computer over USB or FireWire.

The MIDI protocol provides 16 channels of 
MIDI per port. A single MIDI cable can transmit 
a separate set of messages for each of the 16 
channels. These 16 channels can correspond to 
separate MIDI devices or to multiple channels 
within a single device (if the device is multitim-
bral). Each channel can control a different in-

MIDI signal flow

Not all devices will have all three MIDI 
ports (IN, OUT, and THRU).

passes input
strument sound. For example, bass on 
channel 1, piano on channel 2, and drums on 
channel 10. Similar to a multitrack tape re-
corder, a MIDI sequencer can record complex ar-
rangements—even using only a single multitim-
bral keyboard.

MIDI Terms

The following are some basic MIDI terms:

MIDI Instrument A hardware MIDI device or 
software instrument (such as an instrument 
plug-in).

MIDI Interface Hardware that lets computers 
connect to and communicate with MIDI devices 
(such as the M-Audio MIDISPORT). 

MIDI Device Any physical MIDI keyboard, sound 
module, effects device, or other 
equipment that can send or receive MIDI 
information.

MIDI Controller Any MIDI device that transmits 
MIDI performance data. These include MIDI 
keyboards, MIDI guitar controllers, MIDI wind 
controllers, and others. Controllers transmit 
MIDI from their MIDI OUT ports.

MIDI Control Surface Any device (such as the 
Digidesign Command|8), which uses a MIDI 
connection to send control messages to a soft-
ware program, but is not generally used to 
record MIDI information. 

Multitimbral The ability of one MIDI device to 
play several different instrument sounds (such 
as piano, bass, and drums) simultaneously on 
separate MIDI channels. This makes it possible 
for a single multitimbral MIDI instrument to 
play back entire arrangements.
Chapter 2: Pro Tools Concepts 9





To actually hear an external MIDI instrument, 
you need to connect its audio outputs to a mix-
ing console or connect it to one of the audio in-
puts of your Pro Tools audio interface.

Just as each Pro Tools system has unique hard-
ware features, each MIDI device has its own fea-
tures (and limitations) as to the number of 
voices and instruments it can play at one time. 
Refer to the device’s documentation for infor-
mation on its capabilities.

MIDI In Pro Tools

Pro Tools provides powerful MIDI sequencing 
capabilities. You can record, enter, edit, and 
play back MIDI data on Pro Tools Instrument 
and MIDI tracks. These actions can be done in 
the Edit window, the MIDI Editor window, the 
Score Editor window, and the MIDI Event List. 

MIDI data in Pro Tools can be anything from 
MIDI note data (note number, on/off, velocity) 
to System Exclusive (Sysex) messages. MIDI data 
can be recorded or played back from both exter-
nal MIDI devices with a MIDI interface (like the 
Digidesign MIDI I/O or Mbox 2) and other MIDI 
software (such as instrument plug-ins and 
ReWire client applications).

Signal paths for external MIDI instruments
Synchronization
When you are working with multiple time-
based systems, such as Pro Tools and an external 
deck, you want both systems to be synchro-
nized. Synchronization is where one system out-
puts time code or MIDI Beat Clock and another 
device synchronizes to or follows that time code 
or MIDI Beat Clock so that they work together 
according to the same clock source. Pro Tools 
can be synchronized to other devices (or other 
devices can be synchronized to Pro Tools) using 
SMPTE/EBU time code or MIDI Time Code.

Surround
Surround sound simply means having one or 
more speakers with discrete audio signals (chan-
nels) placed behind the listener in addition to 
the typical stereo pair. 

There are multiple types of surround formats in 
use (from three-channel LCR to 7.1, which has 8 
channels).

The most common surround format is 5.1, 
which refers to having 5 speakers and a sub-
woofer (the “.1”). 5.1 is used in movie theaters 
and home entertainment systems. Additionally, 
most DVDs are mixed to 5.1. The standard 
speaker placement for 5.1 for surround monitor-
ing is stereo left and right speakers, and an addi-
tional center speaker in front, two more stereo 
left and right speakers in the rear, and the sub-
woofer on the side. 

For more information on different 
SMPTE/EBU formats, and other concepts 
related to time code, refer to the Pro Tools 
Sync & Surround Concepts Guide.
Chapter 2: Pro Tools Concepts 11
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MIDI Files

When you record or enter MIDI into a Pro Tools 
session, all MIDI data is stored in the Pro Tools 
session file. You can import and export MIDI 
files to and from Pro Tools sessions, but MIDI 
recorded or otherwise created in a Pro Tools ses-
sion does not automatically create new MIDI 
files.

Video Files

When you record or import video into a 
Pro Tools session, all video data is stored as the 
corresponding video file type (such as Quick-
Time). Video files can be created in (or copied 
to) the Video Files folder in the session folder. 
However, in most cases, Pro Tools references 
video files that have been captured by another 
application, such as Avid Media Composer.

Regions

Audio region

MIDI region

Video region (Frames view)
Pro Tools Reference Guide
A region is a segment of audio, MIDI, or video 
data. A region could be a drum loop, a guitar riff, 
a verse of a song, a recording take, a sound ef-
fect, some dialog, or an entire sound file. Re-
gions are especially useful for arranging audio 
and MIDI. A region can also have associated au-
tomation data. In Pro Tools, regions are created 
from audio files or MIDI data, and can be ar-
ranged in audio and MIDI track playlists. Re-
gions can also be grouped (a region of regions) 
and looped (repeated).

Region group (Mixed audio and MIDI multitrack region 
group)
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Channel strip in the Mix window (audio track)
Pro Tools Reference Guide
Signal Routing

Pro Tools provides software-based mixing and 
signal routing controls for audio and MIDI. 
These controls are located in the Mix window. 
Some of these controls can also be accessed from 
the Edit window.

A common audio signal routing task is to sub-
mix multiple tracks to a single channel strip 
(such as an Auxiliary Input) for shared process-
ing and level control. The following example 
shows two audio tracks submixed to a stereo 
Auxiliary Input.

Submixing to an Auxiliary Input

Input from
stereo bus
path

Outputs to
stereo bus
path

Audio tracks

Inserts

Sends

Auxiliary
Input
Track
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Tick-Based and Sample-Based 
Time
Pro Tools lets you set any track timebase to 
either sample-based or tick-based. You can also 
set the Timeline to be viewed as tick-based or 
sample-based.

Audio in Pro Tools is sample-based by default. 
This means that if an audio region is located at a 
particular sample location, it will not move 
from that location if the tempo changes in the 
session—though its Bar|Beat location will 
change.

MIDI data in Pro Tools is tick-based by default. 
This means that if a MIDI region is located at a 
particular Bar|Beat location, it will not move 
from that Bar|Beat location if the tempo changes 
in the session—though its sample location will 
change.

You can select whether a track is sample-based 
or tick-based when it is created, or change time-
bases later. 

Sample-Based Audio and MIDI

With a sample-based audio track, all regions in 
the track have an absolute location on the Time-
line. Regions stay fixed to the sample time, re-
gardless of where tempo or meter changes occur 
in a session.

If you make a MIDI track sample-based, all MIDI 
events in the track have an absolute location on 
the Timeline. MIDI events stay fixed to sample 
time, regardless of any tempo or meter changes 
in a session.
Pro Tools Reference Guide
Tick-Based Audio and MIDI

Tick-based audio is fixed to a Bars|Beat location, 
and moves relative to the sample Timeline when 
tempo and meter changes occur. However, MIDI 
events and tick-based audio respond differently 
to tempo changes with respect to duration. 
MIDI note events change length when tempo or 
meter is adjusted, while audio regions do not 
(unless Elastic Audio is enabled). When Elastic 
Audio is not enabled on an audio track, meter 
and tempo changes affect only the start point 
(or sync point) for each audio region in a tick-
based track. If Elastic Audio is enabled on an au-
dio track, tempo changes apply Elastic Audio 
processing, which changes the duration of the 
audio region.

Elastic Audio

Elastic Audio provides real-time and non-real-
time (rendered) Time Compression and Expan-
sion (TCE) of audio. Tick-based Elastic Audio 
tracks actually change the location of samples 
according to changes in tempo. The audio 
stretches or compresses to match changes in 
tempo. Elastic Audio also provides high-quality 
non-real-time region-based pitch shifting.

Pro Tools Elastic Audio uses exceptionally high-
quality transient detection algorithms, beat and 
tempo analysis, and real-time or rendered TCE 
processing algorithms. Elastic Audio lets you 
quickly and easily tempo conform and beat 
match audio to the session’s Tempo ruler. It also 
provides an unprecedented degree of control 
over transient detection and TCE processing on 
an event-by-event basis.
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Chapter 3: Keyboard and Right-Click 
Mouse Shortcuts
This chapter provides an overview of Pro Tools 
mouse and keyboard shortcuts. 

Right-Click Mouse Shortcuts
Pro Tools provides Right-click shortcuts for 
choosing various Pro Tools commands and 
menus with any Right-click capable mouse. 

Global Key Commands
This section covers keyboard shortcuts that 
apply to many functions in Pro Tools.

A PDF listing of all shortcuts is available in 
Pro Tools. Choose Help > Shortcuts.

For a complete list of Right-click shortcuts, 
see the Shortcuts Guide.

For a complete list of keyboard shortcuts, 
see the Shortcuts Guide.
Track Functions

Pro Tools provides keyboard shortcuts for the 
following track functions:

• Changing Automation mode

• Enabling playlists

• Adding plug-ins

• Record enabling, soloing, and muting 
tracks

• Record safing and solo safing tracks

• Assigning inputs, outputs, and sends

• Toggling volume/peak/delay display

• Clearing meters

• Changing track heights

Command Windows Mac

Apply action to all 
channel strips/tracks

Alt+ 
action

Option+ 
action

Apply action to 
selected channel 
strips/tracks

Alt+ 
Shift+ 
action

Option+ 
Shift+ 
action
Chapter 3: Keyboard and Right-Click Mouse Shortcuts 23
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List and Parameter Selection

Pro Tools provides keyboard shortcuts for the 
following items:

• Selection of tracks in Track List

• Enabling of groups in Group List

• Automation Enable window parameters

• Setting Memory Location parameters

Controls and Editing Tools

Pro Tools provides keyboard shortcuts for mov-
ing plug-in controls, faders and sliders, the 
Scrubber, and automation data.

Keyboard Focus
The Keyboard Focus in Pro Tools determines 
how the alpha keys function. Depending on 
which Keyboard Focus is enabled, you can use 
the keys on your computer (alpha) keyboard to 
select regions in the Region List, enable or dis-
able groups, or perform an edit or play com-
mand.

You can only enable one of the three Keyboard 
Focus modes at a time. Enabling a Keyboard Fo-
cus will disable the one previously enabled.

Command Windows Mac

Toggle item and set 
all others to same 
new state

Alt-click item Option-click 
item

Toggle item and set 
all others to oppo-
site state

Control-click 
item

Command-
click item

Command Windows Mac

Fine adjustment 
of sliders, 
knobs, and 
breakpoints

Hold Control 
while click-
ing the item

Hold Command 
while clicking 
the item
Pro Tools Reference Guide
There are three types of Keyboard Focus:

Commands Keyboard Focus When selected in 
the Tracks pane in the Edit window or in the 
Notes pane of any MIDI Editor window, this 
provides a wide range of single key shortcuts 
from the computer keyboard for editing and 
playing. The frontmost Edit or MIDI Editor win-
dow always receives Commands Keyboard Focus 
when it is enabled.

With Commands Keyboard Focus disabled, you 
can still access any of its key shortcuts by press-
ing the Start key (Windows) or Control (Mac) 
along with the key.

Region List Keyboard Focus When selected, au-
dio regions, MIDI regions, and region groups 
can be located and selected in the Region List by 
typing the first few letters of the region’s name.

Group List Keyboard Focus When selected, Mix 
and Edit Groups can be enabled or disabled by 
typing the Group ID letter (in either the Mix or 
Edit window).

For a complete list of Commands Keyboard 
Focus shortcuts, see the Shortcuts Guide.

Keyboard Focus buttons

Region List
Keyboard Focus

Group List
Keyboard Focus

Commands Keyboard Focus 
(Edit window)
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Transport Mode

This mode allows you to set a number of record 
and play functions, and also operate the Trans-
port from the numeric keypad.
:

With the Numeric Keypad mode set to Transport, 
you can also:

• Play up to two tracks of audio in Shuttle 
Lock mode. Press the Start key (Windows) 
or Control (Mac), followed by 1–9 for dif-
ferent play speeds. 

• Press Plus or Minus to reverse direction.

• Press 0 to stop Shuttle Lock, then press the 
number to resume Shuttle Lock speed.

• Press Escape or Spacebar to exit Shuttle 
Lock mode.

• Recall Memory Locations by typing Period 
(.), the Memory Location number, and Pe-
riod (.) again.

Function Key

Click on/off 7

Countoff on/off 8

MIDI Merge/Replace mode 9

Loop Playback mode on/off 4

Loop Record mode on/off 5

QuickPunch mode on/off 6

Rewind 1

Fast Forward 2

Record enable 3

Play/Stop 0
Pro Tools Reference Guide
Shuttle Mode
(Pro Tools HD Only)

Pro Tools offers another form of shuttling, dif-
ferent from that of the two Shuttle Lock modes. 
With the Numeric Keypad mode set to Shuttle, 
playback of the current Edit selection is trig-
gered by pressing and holding the keys on the 
numeric keypad—playback stops once the keys 
are released. Various playback speeds are avail-
able in both forward and reverse. In this mode, 
pre- and post-roll are ignored.
:

With the Numeric Keypad mode set to Shuttle, 
you can also:

• Recall Memory Locations by typing Period (.), 
the Memory Location number, and Period (.) 
again.

Playback Speeds Key

1x Forward 6

1x Rewind 4

4x Forward 9

4x Rewind 7

1/4x Forward 3

1/4x Rewind 1

1/2x Forward 5+6

1/2x Rewind 5+4

2x Forward 8+9

2x Rewind 8+7

1/16x Forward 2+3

1/16x Rewind 2+1

Loop Selection (1x) 0

Shuttle Lock modes are not available when 
the Numeric Keypad mode is set to Shuttle.
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Pro Tools|HD Systems

Pro Tools|HD 1

Includes:

• Accel Core (for PCIe) card or 
HD Core (for PCI) card

• Pro Tools HD software

Pro Tools|HD 2 Accel

Includes:

• Accel Core (for PCIe) card or 
HD Core (for PCI) card

• HD Accel card 

• Pro Tools HD software

Pro Tools|HD 3 Accel

Includes:

• Accel Core (for PCIe) card or
HD Core (for PCI) card

• Two HD Accel cards

• Pro Tools HD software

Pro Tools|HD 2

Includes:

• HD Core card

• HD Process card

• Pro Tools HD software

Pro Tools|HD 3

Includes:

• HD Core card

• Two HD Process cards

• Pro Tools HD software
Pro Tools Reference Guide
Expanded Pro Tools|HD Systems

Any Pro Tools|HD system can be expanded by 
adding additional HD Process or HD Accel cards. 
For more information, see the Expanded Systems 
Guide.

Supported Audio Interfaces
(Pro Tools|HD Systems Only)

The following audio interfaces are compatible 
with Pro Tools|HD systems:

• 192 I/O™

• 192 Digital I/O™

• 96 I/O™

• 96i I/O™

The following “Legacy” Digidesign audio inter-
faces are supported with Pro Tools|HD systems:

• 888|24 I/O™ and 882|20 I/O™

• 1622 I/O™

• 24-bit ADAT Bridge I/O™

HD Accel and HD Process cards can be used 
in the same system. For more information, 
refer to the Pro Tools|HD Setup Guide.

Pro Tools|HD systems require the use of at 
least one 192 I/O, 192 Digital I/O, 96 I/O, 
or 96i I/O.

“Legacy” I/Os (such as 888|24 I/O) require 
the use of at least one 192 I/O, 192 Digital 
I/O, 96 I/O, or 96i I/O.



Pro Tools|HD System Playback, Recording and Voice Limits

The following table lists the audio playback, recording, and voiceable track limits of each type of 
Pro Tools|HD system. Playback and recording voices refer to the number of unique simultaneous 
playback and record tracks on your system. Total voiceable tracks refers to the maximum number of 
audio tracks that can share the available voices on your system. (Mono tracks take up one voice. Ste-
reo and multichannel tracks take up one voice per channel.) Voice limits are dependent on the ses-
sion sample rate and the number of DSP chips dedicated to the system’s Playback Engine. 
Pro Tools|HD systems can open sessions with up to 256 audio tracks, but any audio tracks beyond that 
system’s voiceable track limit will be automatically set to Voice Off. 
Table 5. Pro Tools|HD system audio playback, recording a
nd voice limits
Pro Tools|HD systems provide up to 160 Auxiliary Input tracks and a total of 128 internal mix busses. 
These systems also provide up to 10 inserts and 10 sends per track (depending on the DSP capacity of 
your system). Pro Tools|HD systems also support up to 128 Instrument tracks, 256 MIDI tracks, 
128 VCA Master tracks, and multiple video tracks.

Core System Type
Sample 
Rate
(kHz)

Playback 
Voices 
(Mono Tracks of 
Simultaneous 
Playback)

Recording 
Voices 
(Mono Tracks of
Simultaneous
Recording)

Total 
Voiceable 
Tracks

Pro Tools|HD 1 44.1/48 96 96 112

88.2/96 48 48 48

176.4/192 18 (for PCIe)
12 (for PCI)

18 (for PCIe)
12 (for PCI)

18 
(for PCIe)

12 
(for PCI)

Pro Tools|HD Accel 2,
Pro Tools|HD Accel 3

44.1/48 192 192 224

88.2/96 96 96 120

176.4/192 36 36 36

Pro Tools|HD 2,
Pro Tools|HD 3,
or any expanded Pro Tools|HD system

44.1/48 128 128 224

88.2/96 64 64 80

176.4/192 24 24 24
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Pro Tools LE Systems
Pro Tools LE-based systems are available in the 
following configurations:

003

A 003 system includes:

• Pro Tools LE software

• 003 audio and MIDI interface (with 
control surface)

003 Rack+

A 003 Rack+ system includes:

• Pro Tools LE software

• 003 Rack+ audio and MIDI interface

003 Rack

A 003 Rack system includes:

• Pro Tools LE software

• 003 Rack audio and MIDI interface

Digi 002

A Digi 002 system includes:

• Pro Tools LE software

• Digi 002 audio and MIDI interface (with 
control surface)

Digi 002 Rack

A Digi 002 Rack system includes:

• Pro Tools LE software

• Digi 002 Rack audio and MIDI interface
Mbox 2 Pro

An Mbox 2 Pro system includes:

• Pro Tools LE software

• Mbox 2 Pro audio and MIDI interface

Mbox 2

An Mbox 2 system includes:

• Pro Tools LE software

• Mbox 2 audio and MIDI interface

Mbox 2 Mini

An Mbox 2 Mini system includes:

• Pro Tools LE software

• Mbox 2 Mini audio interface

Mbox 2 Micro

An Mbox 2 Micro system includes:

• Pro Tools LE software

• Mbox 2 Micro audio interface

Mbox

An Mbox system includes:

• Pro Tools LE software

• Mbox audio interface

Processing Capacity

The total processing capacity of a 
Pro Tools LE system depends on the pro-
cessing power of your computer. Contact 
your Digidesign dealer or visit Digidesign’s 
website (www.digidesign.com) for the latest 
system requirements and compatibility 
information.
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Pro Tools M-Powered
A Pro Tools M-Powered system includes:

• Pro Tools M-Powered software

• Digidesign-qualified M-Audio interface (not 
supplied with M-Powered software)

Toolkit Software Options
In addition to all the regular capabilities pro-
vided with Pro Tools LE and Pro Tools M-Pow-
ered, Pro Tools LE systems equipped with Com-
plete Production Toolkit or DV Toolkit 2 and 
Pro Tools LE and M-Powered systems equipped 
with Music Production Toolkit 2 provide ex-
panded capabilities.

References to Pro Tools LE in this guide are 
usually interchangeable with Pro Tools 
M-Powered, except as noted in the 
Pro Tools M-Powered Setup Guide.

For the most current list of Digidesign-qual-
ified M-Audio interfaces, visit the Digi-
design website (www.digidesign.com).

The Complete Production Toolkit option in-
cludes all of the of the features and addi-
tional software that is included with the DV 
Toolkit 2 option and the Music Production 
Toolkit 2 option.
Complete Production Toolkit 
Capabilities
(Pro Tools LE Only)

Pro Tools Features

Complete Production Toolkit enables the fol-
lowing features in Pro Tools LE:

• Session and track features:

• Up to 128 mono or 64 stereo audio tracks of 
simultaneous playback or recording

• Ability to use QuickPunch on up to 64 
tracks

• Up to 64 Instrument tracks

• 128 internal busses

• Display of up to 256 tracks

• Multiple video tracks, with multiple video 
playlists and multiple QuickTime movies 
per track.

• Import Session Data options (Destination 
Track Names, Time Code Mapping, Find 
Matching Tracks, Session Data to Import, 
Track Playlist)

• MP3 export option (for bounce recording 
or exporting a region as an MP3 file)

• DigiBase Pro (including support for Catalog 
browsers and the ability to search on mul-
tiple criteria simultaneously in DigiBase 
browsers)

• Beat Detective features:

• Ability to apply Beat Detective across mul-
tiple tracks

• Collection Mode
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• Editing features:

• Video Universe window

• Continuous Scroll

• Scrub Trim tool

• Replace Region command

• TCE Edit to Timeline Selection command

• Selection of alternate field recorder audio 
channels in the Pro Tools Timeline

• Expanding alternate field recorder audio 
channels to new tracks

• Mixing and Automation features:

• Surround mixing up to 7.1 (003, 003 Rack, 
Digi 002, Digi 002 Rack, and Mbox 2 Pro 
only)

• Snapshot automation for writing or trim-
ming automation data

• Glide Automation commands

• Time code and synchronization features:

• Timebase rulers (Time Code and 
Feet+Frames)

• Time Code Rate selector

• Feet+Frame Rate selector

• Current Time Code Position command

• Current Feet+Frames Position command

• Use Subframes option

• Audio Rate Pull Up and Pull Down

• Video Rate Pull Up and Pull Down

• Session interchange between Pro Tools HD 
and Pro Tools LE
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Additional Software

Complete Production Toolkit includes addi-
tional software for working with Pro Tools:

DINR™ (Digidesign Intelligent Noise Reduction™) 
LE Plug-in For reducing noise in audio.

DigiTranslator™ 2.0 Software Option For ex-
changing audio and video files, and sequences 
with other AAF and OMFI-compatible applica-
tions.

Eleven LE Plug-in For use as a guitar amp and 
speaker emulation.

Hybrid Synthesizer Plug-in For use as a virtual in-
strument in your Pro Tools sessions.

Neyrinck SoundCode Stereo™ Down Mixer 
Plug-in For monitoring 5.1 surround sessions 
(down mixed to stereo) with all LE interfaces in-
cluding 2 channel interfaces (such as the Mbox 
2 Micro). This plug-in also lets you quickly and 
easily create stereo mixes from 5.1 surround 
sessions.

Smack!™ LE Compressor Plug-in For applying 
compression to your audio.

Structure® LE Plug-in For use as a virtual instru-
ment in your Pro Tools sessions.

TL Space Native™ Convolution Reverb Plug-in For 
applying convolution reverb to your audio.

X-Form Plug-in For high-quality time compres-
sion and expansion, and formant corrected 
pitch-shifting (based on the Radius® algorithm 
from iZotope).



DV Toolkit 2 Capabilitites
(Pro Tools LE Only)

Pro Tools Features

DV Toolkit 2 enables the following features for 
working with audio, film, video, or digital video 
in Pro Tools LE:

• Session and track features:

• Up to 64 audio tracks of simultaneous play-
back or recording, mono or stereo

• Ability to use QuickPunch simultaneously 
on up to 32 tracks at 48 kHz and up to 24 
tracks at 96 kHz

• Multiple video tracks, with multiple video 
playlists and multiple QuickTime movies 
per track.

• Import Session Data options (Destination 
Track Names, Time Code Mapping, Find 
Matching Tracks, Session Data to Import, 
Track Playlist)

• MP3 export option (for bounce recording 
or exporting a region as an MP3 file)

• DigiBase Pro (including support for Catalog 
browsers and the ability to search on mul-
tiple criteria simultaneously in DigiBase 
browsers)

• Editing features:

• Video Universe window

• Continuous Scroll

• Scrub Trim tool

• Replace Region command

• TCE Edit to Timeline Selection command

• Selection of alternate field recorder audio 
channels in the Pro Tools Timeline

• Expanding alternate field recorder audio 
channels to new tracks
• Mixing and Automation features:

• Snapshot automation for writing or trim-
ming automation data

• Glide Automation commands

• Time code and synchronization features:

• Timebase rulers (Time Code and 
Feet+Frames)

• Time Code Rate selector

• Feet+Frame Rate selector

• Current Time Code Position command

• Current Feet+Frames Position command

• Use Subframes option

• Audio Rate Pull Up and Pull Down

• Video Rate Pull Up and Pull Down

Additional Software

DV Toolkit 2 includes additional software for 
working with audio or digital video in Pro Tools:

DINR (Digidesign Intelligent Noise Reduction™) 
LE Plug-in For reducing noise in audio.

DigiTranslator 2.0 Software Option For exchang-
ing audio and video files, and sequences with 
other AAF and OMFI-compatible applications.

TL Space Native Convolution Reverb Plug-in For 
applying convolution reverb to your audio.

X-Form Plug-in For high-quality time compres-
sion and expansion, and formant corrected 
pitch-shifting (based on the Radius® algorithm 
from iZotope).
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Music Production Toolkit 2
(Pro Tools LE and Pro Tools M-Powered Only)

Pro Tools Features

Music Production Toolkit 2 enables the follow-
ing features in Pro Tools LE and M-Powered:

• Session and track features:

• Up to 64 audio tracks of simultaneous play-
back or recording, mono or stereo

• Ability to use QuickPunch simultaneously 
on up to 32 tracks at 48 kHz and up to 24 
tracks at 96 kHz

• MP3 export option (for bounce recording 
or exporting a region as an MP3 file)

• Beat Detective features:

• Ability to apply Beat Detective across mul-
tiple tracks

• Collection Mode

Additional Software

Music Production Toolkit 2 includes additional 
software for working with Pro Tools:

Eleven LE Plug-in For use as a guitar amp and 
speaker emulation.

Hybrid Synthesizer Plug-in For use as a virtual in-
strument in your Pro Tools sessions.

Smack! LE Compressor Plug-in For applying 
compression to your audio.

Structure LE Plug-in For use as a virtual instru-
ment in your Pro Tools sessions.

TL Space Native Convolution Reverb Plug-in For 
applying convolution reverb to your audio.
Pro Tools Reference Guide
Checking For Software 
Updates
Pro Tools can check for Pro Tools application 
and Digidesign plug-in updates, either automat-
ically or manually. An internet connection is re-
quired to be able to check for updates. Approxi-
mately every two weeks, Pro Tools checks online 
for any available application and plug-in up-
dates.

If updates are available for Pro Tools or any 
plug-ins, Pro Tools reports what updates (if any) 
are available and how important the updates are 
for your system. You can visit the Digidesign 
website to locate, download, and install the 
appropriate updates for your Pro Tools system.

To manually check for updates:

1  Ensure that your internet connection is func-
tioning properly.

2  Launch Pro Tools.

3  Choose Help > Check For Updates, and a 
progress dialog appears.

4  Depending on whether or not any updates are 
available, do one of the following:

• If no updates are available, click OK.

– or –

• If updates are available, do one of the follow-
ing:

• Click Details to launch your web browser 
and see what updates are available for 
download.

• Click Not Now if you do not want to review 
or download updates until later.



To disable checking for software updates 
automatically:

In the Software Update dialog, select the 
Do Not Check For Updates Automatically option.

To enable checking for software updates 
automatically:

1  Check for updates manually (Help > Check For 
Updates). 

2  In the Software Update dialog, deselect the 
Do Not Check For Updates Automatically option.
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Chapter 5: System Setup
Starting Up or Shutting Down 
Your System
To ensure that the components of your 
Pro Tools system communicate properly with 
each other, you need to start them in a particu-
lar order.

Start up your Pro Tools system in this order:

1  Make sure all your equipment (including your 
computer) is off.

2  Lower the volume of all output devices in your 
system. 

3  For Pro Tools|HD systems with an expansion 
chassis, turn on the chassis.

4  Turn on any external hard drives. Wait ap-
proximately ten seconds for them to spin up to 
speed.

5  Turn on any worksurfaces (such as 
D-Command) or control surfaces (such as 
Command|8).

6  Turn on any MIDI interfaces, MIDI devices, or 
synchronization peripherals.
7  Do one of the following, depending on your 
Pro Tools system:

• For Pro Tools|HD systems, with the volume 
of all output devices lowered, turn on your 
Pro Tools Legacy I/O (such as an 888|24 I/O 
or 882|20 I/O) first, then your Pro Tools|HD 
audio interfaces (such as 96 I/O). Wait at 
least fifteen seconds for your system hard-
ware to initialize.

– or –

• For Pro Tools LE and M-Powered systems 
that use hardware requiring external power 
(such as 003), turn on the hardware.

8  Turn on your computer. 

9  Launch Pro Tools or any third-party audio or 
MIDI applications. 

Shut down your Pro Tools system in this order:

1  Quit Pro Tools and any other running applica-
tions. 

2  Turn off or lower the volume of all output de-
vices in your system. 

3  Turn off your computer.

To quit Pro Tools, choose File > Exit (Win-
dows) or Pro Tools > Quit (Mac).
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4  Do one of the following depending on your 
Pro Tools system:

• For Pro Tools|HD systems, turn off your 
Pro Tools audio interfaces.

– or –

• For Pro Tools LE and M-Powered systems 
that use hardware requiring external power 
(such as 003), turn off the hardware.

5  For Pro Tools|HD systems with an expansion 
chassis, turn off the chassis.

6  Turn off any MIDI interfaces, MIDI devices, or 
synchronization peripherals.

7  Turn off any worksurfaces (such as 
D-Command) or control surfaces (such as 
Command|8).

8  Turn off any external hard drives.

Checking an HD System with 
DigiTest
Before you use Pro Tools, you may want to run 
the DigiTest diagnostic application to ensure 
that all Pro Tools|HD cards in the system are rec-
ognized, installed in the proper order, and have 
valid TDM FlexCable connections. See the HD 
Setup Guide for more information.

Configuring Pro Tools System 
Settings
Pro Tools lets you adjust the performance of 
your system by changing system settings that 
affect its capacity for processing, playback, and 
recording. These system settings are available in 
the Playback Engine dialog (Setup > Playback 
Engine).
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In most cases, the default settings for your sys-
tem provide optimum performance, but you 
may want to adjust them to accommodate large 
or processing-intensive Pro Tools sessions. 

Hardware Buffer Size

The Hardware Buffer Size (H/W Buffer Size) con-
trols the size of the buffer used to handle host 
processing tasks such as Real-Time AudioSuite™ 
(RTAS) plug-ins. 

• Lower Hardware Buffer Size settings are useful 
for improving latency issues in certain record-
ing situations or for improving certain system 
performance problems.

• On all Pro Tools systems, lower settings re-
duce RTAS MIDI-to-audio latency (such as 
when playing an RTAS virtual instrument 
live and monitoring the instrument’s out-
put). Lower settings can also improve 
screen response or the accuracy of plug-in 
and mute automation data.

• On Pro Tools LE systems, lower settings re-
duce all input-to-output monitoring la-
tency on any record-armed tracks or 
Auxiliary Input tracks with live inputs.

• On Pro Tools HD systems, lower settings re-
duce monitoring latency that occurs on 
tracks that have one or more RTAS plug-ins. 
Lower settings can also improve the accu-
racy of MIDI track timing on systems with-
out a MIDI interface that supports time 
stamping . Lower settings also improve 
MIDI track timing on tracks using MIDI 
virtual instruments that do not support 
time stamping .

• Higher Hardware Buffer Size settings are use-
ful for sessions that are using more RTAS plug-
ins for playback. These settings allow for more 
audio processing. They can also be useful to 
reduce errors on machines that require a 
higher buffer size.



To change the Hardware Buffer Size:

1  Choose Setup > Playback Engine. 

2  From the H/W Buffer Size pop-up menu, select 
the audio buffer size, in samples. 

3  Click OK. 

RTAS Processors

The RTAS Processors setting determines the 
number of processors in your computer allo-
cated for RTAS (Real-Time AudioSuite) plug-in 
processing.

With computers that have multiple processors, 
or that feature multi-core processing or hyper-
threading, this setting lets you enable multipro-
cessor support for RTAS plug-ins. Used in combi-
nation with the CPU Usage Limit setting, the 
RTAS Processors setting lets you control the way 
RTAS processing and other Pro Tools tasks are 
handled by the system. 

Playback Engine dialog for Pro Tools|HD system
For example: 

• For sessions with large numbers of RTAS plug-
ins, you can allocate 2 or more processors to 
RTAS processing and set a high CPU Usage 
Limit.

• For sessions with few RTAS plug-ins, you can 
allocate fewer processors to RTAS processing 
and set a low CPU Usage Limit to leave more 
CPU resources available for automation accu-
racy, screen response, and video. 

• Increase these settings to accommodate TDM 
to RTAS plug-in conversion. Conversely, de-
crease these settings if you are only using 
TDM plug-ins or are converting RTAS plug-ins 
to TDM. TDM/RTAS conversion can be desir-
able during recording, depending on latency, 
voicing needs, and record-monitoring capa-
bilities of the specific TDM and RTAS plug-ins. 

• Depending on the importance of video and 
overall screen response, and on the density of 
automation being employed, try different 
combinations of RTAS Processors and CPU Us-
age Limit settings to achieve the best results. 
For example, to improve screen response in a 
medium-sized session using a moderate num-
ber of RTAS plug-ins, try reducing the number 
of RTAS plug-ins, but keep the CPU Usage Limit 
set to the maximum (up to 99% on a single 
processor system).
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• Enable RTAS error suppression only if you are 
experiencing frequent RTAS errors that are in-
terrupting your creative workflow. When 
RTAS error suppression is enabled, you can ex-
perience a degradation of audio quality. How-
ever, this may be acceptable in order to avoid 
interrupting playback and recording when 
working with instrument plug-ins. 

• Disable RTAS error suppression when you 
need to ensure the highest possible audio 
quality, such as for a final mix.

To enable RTAS error suppression:

1  Choose Setup > Playback Engine.

2  Select Ignore Errors During Playback/Record.

3  If available, you can also select Minimize Addi-
tional I/O Latency.

4  Click OK.

Playback Engine dialog, Mbox 2
RTAS Error Suppression Options

Ignore Errors During Playback/Record When en-
abled, Pro Tools continues to play and record 
even if the RTAS processing requirements ex-
ceed the selected CPU Usage Limit. This can result 
in pops and clicks in the audio, but does not 
stop the transport.

Minimize Additional I/O Latency (Pro Tools LE and 
M-Powered Only) When enabled, any additional 
latency due to suppressing RTAS errors during 
playback and record is minimized to 128 sam-
ples. Suppressing RTAS errors requires at least 
128 samples of additional buffering on some 
systems. If this option is disabled, the buffer is 
half the H/W Buffer Size, or at least 128 samples 
(whichever is greater). If you are on an older, 
slower computer, you may want to disable this 
option to avoid adverse performance.

This option is only available if the Ignore Errors 
During Playback/Record option is enabled and 
the Pro Tools system you are using requires ad-
ditional buffering for RTAS error suppression, as 
follows:

• Windows:

• Mbox 2 Pro

• All Pro Tools M-Powered systems

• Mac:

• 003, 003 Rack+, and 003 Rack

• Mbox 

• Mbox 2

• Mbox 2 Pro

• Mbox 2 Mini

• Mbox 2 Micro

• Digi 002 and 002 Rack

• All Pro Tools M-Powered systems
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